Figures

Figure 1: Registration form for SET ................................................................. 5
Figure 2: User Login Name after Registration .................................................. 5
Figure 3: Layout of SET window (work and user area) ...................................... 7
Figure 4: Language change (Ger./Eng.) in SET ............................................... 8
Figure 5: Example for providing the SIEMENS XML file ................................. 11
Figure 6: Importing databases for safety-related values (*.xml format) ............... 11
Figure 7: Dialog window to select a database for safety-related values .............. 12
Figure 8: Load your OEM manufacturer database for safety-related values devices 12
Figure 9: Search for correct directory (with XML file) .................................... 12
Figure 10: Selecting the archive directory ...................................................... 12
Figure 11: Up to a maximum of 10 parameter libraries can be simultaneously selected ................................................................. 13
Figure 12: Create a new project, choose ISO or IEC standard ........................... 14
Figure 13: General description of the project .................................................. 15
Figure 14: General description of the safety area ............................................. 16
Figure 15: Create a new safety function (layout) ............................................. 17
Figure 16: General Safety function description (here: IEC) ............................... 17
Figure 17: Defining the required SIL .............................................................. 19
Figure 18: Defining the required PL ............................................................... 20
Figure 19: Editing Sensor Group .................................................................... 21
Figure 20: Selecting SIEMENS as Sensor (e. g. Pushbutton with S7 connection, ET200M) ................................................................. 22
Figure 21: Selecting Third-Party manufacturer for Sensor-type .......................... 23
Figure 22: Sensor integration via XML product import (e. g. OEM "Musterfirma2") ................................................................. 24
Figure 23: Setting the S7-ES Pushbutton Logic evaluation (from S7 Connection, ET200M, F-DI24) ......................................................... 25
Figure 24: Editing the S7-CPU Logic controller (e. g. S7 – F-CPU, CPU317F-2DP/PN) ................................................................. 26
Figure 25: Select manufacturer, e.g. Bihl+Wiedemann logic controller ............ 26
Figure 26: "Product parameters": Make the settings (selection criterion 1 – 5) for the third-party product ........................................ 27
Figure 27: General description of Actuator group, create subsystem ................. 27
Figure 28: Selecting the Drive Wizard (for Drives only) .................................... 29
Figure 29: Setting the Drive Wizard ............................................................... 29
Figure 30: Failure Message from Drive Wizard dialog .................................... 30
Figure 31: Selection of an OEM device – actuator via XML Import (e. g. B+W Safety monitor) ................................................................. 31
Figure 32: Final Actuator – Group (made with Drive Wizard) ............................ 32
Figure 33: Report out of Safety Evaluation Tool ............................................. 33
1 General

1.1 Warranty, Liability and Support

The TUEV-approved Safety Evaluation Tool is provided to you free of charge. Therefore, no warranty is granted for the present report with the exception of willful or fraudulent behavior. This particularly applies to the tool’s correctness, freedom from errors, completeness and usability.

Use of the Safety Evaluation Tools is voluntary and subject to your own risk. As far as SIEMENS provides technical support with the tool’s use or with report generation, such support is granted on a voluntary basis and without acknowledgement of any statutory duty.

With the exception of personal injury, the liability of SIEMENS and its vicarious agents is solely limited to cases of intent and gross negligence and to the extent of foreseeable and typical damage as generally applied in contracts.

In particular, SIEMENS does not relieve you of your responsibility for fulfilling product safety obligations.

1.2 Description of the Functionality

The SIEMENS Safety Evaluation Tool provides valuable support with the rapid and easy assessment of safety functions in machines and systems.

The TÜV-tested online tool offers step-by-step user guidance, from specification of the safety system’s structure, to component selection, down to the determination of the attained safety integrity in accordance with ISO 13849-1 and IEC 62061. This is also supported by the comprehensive integrated libraries.

As a result, the user is provided with a standard-compliant report, which can be integrated in the documentation as safety proof. The decision whether the report can be used for possible acceptance tests is at the discretion of the relevant test center.

Accessing the Safety Evaluation Tool online means you are always able to carry out calculations based on the current standards listed there. You can also call up the latest technical data for all safety-relevant components from SIEMENS.

1.3 Prerequisites

A prerequisite for using the Safety Evaluation Tool is that you carry out a hazard assessment (risk analysis) beforehand which defines the required safety functions.

Here, generally the logical functions with the already envisaged hardware sub-functions (e.g. detection, evaluation and reaction) are to be selected.

Furthermore, the persons in charge (project manager and project inspector) of the final acceptance tests have to be named.

1.4 Important Notes

The Safety Evaluation Tool is an online tool. All created projects are only saved locally on your PC. The project data are not saved on the SIEMENS online server.

If no entries are made for a period exceeding 30 minutes, the online connection will be interrupted after display of a respective note. In this case, any unsaved projects / changes will be deleted.

Therefore, please regularly save your project data via File > Save projects or by clicking the Unsaved changes field.
2 Call-Up of the Safety Evaluation Tool

2.1 Link to the Safety Evaluation Tool

www.SIEMENS.de/safety-evaluation-tool

2.2 Registration

![Registration form Safety Evaluation Tool](image)

**Figure 1:** Registration form for SET

Upon first call-up of the Safety Evaluation Tool, you are requested to register yourself. Please fill in the registration screen completely (* = mandatory field). Please observe that these entries appear in the Safety Evaluation Tool and in the report under *Last editor*.

![User Login Name after Registration](image)

**Figure 2:** User Login Name after Registration
Following registration, you will receive an e-mail containing your access data (login name and password) for further use of the Safety Evaluation Tool.

The subsequent first-time registration process comprises some questions which are aimed at better matching our products to your needs in the future.

Of course, the Safety Evaluation Tool's use is free of charge.
3 Operation of the Safety Evaluation Tool

The sections below describe the general functional principle of the Safety Evaluation Tool on the basis of an example.

3.1 Screen font sizes

The font sizes of the screens can be changed in the Internet Explorer via View > Zoom or Text size.

3.2 Screen layout

Here you find information about the different section of the SET.

---

Figure 3: Layout of SET window (work and user area)

The screens of the Safety Evaluation Tool are divided into four general sections:

1. General buttons:
   - **File** Pull-down menu with the following sub-items:
     - **New workspace**: Deletes the entire workspace under User projects
     - **Load projects**: Loads and opens a locally saved project under User projects
     - **Import project**: Loads and adds a further project to the currently open project (under User projects)
     - **Save projects**: Locally saves the open project or several projects under User projects to a file (*.set); alternatively, the project can also be saved by clicking the unsaved changes field
     - **Database for safety-related values**: Function for importing XML files (VDMA format) from OEM device manufacturer (see cap. 3.4)
   - **Project** Pull-down menu with the following sub-items:
     - Creation of New IEC 62061 project
     - Creation of New ISO 13849-1 project
     - Creation of New safety area
     - Creation of New safety function
     - Creation of New subsystem or SRP/CS
     - **Export project**
   - **Copy selection**: Copies the selected component (tree node under Library or User projects) to the cache
   - **Paste selection**: Pastes the component from the cache (tree node under User projects)
   - **Delete selection**: Deletes the selected component (tree node under User projects)
• **Create report:** The result report of the currently selected project is created via this button (see cap. 3.5.14)
• **Options:** Activates or de-activates the display of the product actuality in the project tree
• **Getting Started:** Link to this document
• **Terms:** Link to the reference “Safety Integrated, Terms and Standards”
• **Forum:** Link to the "Safety Evaluation Tool" online forum for questions, suggestions and additional information

2. Navigation tree of **Library** (example projects pre-defined by SIEMENS) and **Projects** (customer projects)
   The symbols in the navigation tree have the following meaning:
   o ▶ By clicking this symbol, all elements and their sub-levels are displayed
   o ▼ By clicking this symbol, all elements and their sub-levels are minimized
   o ▲ Further elements are available under the element, which are displayed by clicking the arrow
   o ▼ The elements available under the element are displayed; they can be minimized by clicking the arrow
   o ▶ Lowermost level of the project
   o ⚠️ Required entries are missing under the tree node
   o ⚠️ The function does not meet the required SIL or PL
   o ✪ Product update information is available (e.g. product can no longer be ordered). For more details, select the corresponding product

3. Workspace in which all required entries are made

4. Section for display of the current login name; language selection of the Safety Evaluation Tools via the ⬇️ symbol.

![Figure 4: Language change (Ger./Eng.) in SET](image)

User change via ➔ Logout
3.3 Library

Typical example projects, which can be used as basis for your own projects, are available under Library.

3.3.1 Inserting Safety Functions from Libraries

To insert a safety function from a library in User projects, proceed as follows:
- Select the exemplary safety function in accordance with the respectively applicable standard in Library
- Operate the Copy selection button
- Create a new project under User projects or select an existing project
- Create a new safety area in this project or select an existing safety area
- Select this safety area
- Operate the Paste selection button

3.3.2 Inserting Sub-Systems or SRP/CS from Libraries

Besides complete safety functions, also only individual sub-systems or SRP/CS can be inserted in User projects from a Library. The procedure is as follows:
- Select the exemplary sub-system or SRP/CS in accordance with the applicable standard in Library
- Operate the Copy selection button
- Create a new project under User projects or select an existing project
- Create a new safety area in this project or select an existing safety area
- Create a new safety function in this safety area or select an existing safety function
- Select the respective level (DETECTION, EVALUATION or REACTION)
- Operate the Paste selection button
- Delete the sub-system or SRP/CS, which was automatically inserted and may no longer be required after copying, in User projects
3.4 Database for safety-related values

The SET calculation tool corresponds to the new VDMA standard (standard sheet 66413) which generally provides the possibility to import data from other manufacturers into SET using the XML format.

The XML files from external manufacturers are not provided by SIEMENS. These files can, however, be imported directly via the corresponding quotations made by external manufacturers provided that the technical prerequisites are provided. SIEMENS can therefore not check the data supplied by external manufacturers for completeness, correctness and topicality. It can therefore not be excluded that some data are incorrect, incomplete, obsolete or unusable for the user.

SIEMENS does not assume any responsibility for this.

After importing the XML files, the SET Safety Evaluation Tool only evaluates the data volume in order to determine whether the structure corresponds to the VDMA standard. It is, however, not checked whether the imported data are complete, correct, topical and/or usable.

Before import of product data from external manufacturers, please observe the manufacturer-specific information as well as any further increased due diligence in the safety-relevant area.

The following chapter describes in detail how an import of this type functions in principle.

3.4.1 Provision of XML data (Import of OEM device manufacturer data)

Before importing data, the product data from the third-party manufacturer must be saved on a local drive (hard disk or network drive), using either

- Download (URL link)
- File-Transfer
- or data storage medium (USB, floppy disk, etc.)

The format must be *.xml and the structure must be in compliance with the VDMA66413 specification sheet. Data from safety-related products from OEM device manufacturer can then be imported directly into the Safety Evaluation Tool.

The database for safety-related values is only available during the online session. The XML file is not kept after logging off. However, third-party products already loaded from the database for safety-related values remain saved in the SET project file after logging off, assuming that the project is saved before logging off.

Note:

Please note that the data you have stored on your drive are not updated automatically. Every user is responsible for updating the imported data (KWB)!

3.4.2 Providing SIEMENS XML file

SIEMENS is providing – as other reputable manufactures – even their safety-related product data in form of a VDMA compatible XML file for free download.
Figure 5: Example for providing the SIEMENS XML file

You can download the file from the following link:
3.4.3 Use of import function

Data is imported into the SET using the "File/Databases for safety-related values" menu item.

Figure 6: Importing databases for safety-related values (*.xml format)

The following screen form is then displayed:

Figure 7: Dialog window to select a database for safety-related values

Up to 10 different parameter libraries can be simultaneously imported by clicking on the "Add..." button.

Figure 8: Load your OEM manufacturer database for safety-related values devices

Figure 9: Search for correct directory (with XML file)

Figure 10: Selecting the archive directory
Using the screen forms as shown in Fig. 7 - 10, the user selects the archive directory of his XML characteristic value libraries to be imported, and then confirms the selection of the database(s) for safety-related values with "OK" (refer to the following screen).

![Image of the screen forms](image)

**Figure 11**: Up to a maximum of 10 parameter libraries can be simultaneously selected.

After confirming with "OK", the data is imported, and at the same time, the imported XML file is checked for consistency and the checksum.

After the check has been successfully completed, the data is imported without any additional messages. The user then has the data available to him for further processing in the Safety Evaluation Tool.

An appropriate error message is displayed if the check was not successful.

**Note:**

The **SIEMENS XML library cannot be imported**, as all SIEMENS device data are already included in the Safety Evaluation Tool.

If more than 10 parameter libraries are required, then additional libraries must be imported in a second step. The SET project can then be created as usual (see Chapter 3.5); create safety level and safety structure as required – and search for products in the corresponding screen forms for sensors, logic and actuators and insert.

Only one version of XML library is valid. More than one version of a library of one OEM device manufacturer cannot be loaded at the same time.
3.5 Creating User Projects

Note:

The locally saved file is not changed by loading, copying and deleting.
The local file (*.set) is only overwritten with the current data upon saving.

3.5.1 Loading existing projects

Already created projects can be loaded locally from a *.set file (e.g. from your PC’s hard disk or a company-internal server) via File > Load projects. These projects can be subsequently further edited or used as basis for new projects.

3.5.2 Adding an Existing Safety Area / Function

To add a safety area or a safety function from a previously created project to an open project, proceed as follows:

- Operate Load > Import project and select the respective project with the desired safety area or the desired safety function
- After insertion of the project, select the desired safety area or safety function via Copy selection
- Insert the safety area or safety function in your project via Paste selection
- The project no longer required can be subsequently deleted via Delete selection

3.5.3 Creating a New Project

To create a new project, select User Projects and operate the New project button. Select the applicable standard for this project in the automatically opened dialog.

Figure 12: Create a new project, choose ISO or IEC standard

IEC 62061 is used for this example.

The next chapters feature a step-by-step description of the Safety Evaluation Tool’s individual screens and the required entries. Screens which differ due to general differences in the standards are illustrated consecutively.
3.5.4 Project - General Description Editing

The term project refers to the summarization of one or several safety areas and safety functions of a system or machine.

Figure 13: General description of the project

The following information on the project has to be entered under Project – General description:

- **Name** of the project
- **Manager** for the project
- **Inspector** for the project
- **System type**
- **Name of the Document** for risk assessment
- **Description** of the project
- **Help** for each function in SET

With the Help button you will get additional Information about the selected standard, e. g. information about the calculation of the DC value, etc.

Then, operate the **New safety area** button under Further functions.
3.5.5 Safety Area – General Description Editing

The term safety area refers to a grouping of several safety functions of a project or system. At least one safety area is required. A safety area helps to “structure” your machine in order to assign the safety functions to specific system sections.

Figure 14: General description of the safety area

The following information on the safety area has to be entered under Safety area – General description:

- **Name** of the safety area
- **Description** of the safety area
- **Help** Information about the settings of the safety area

Then, operate the **New safety function** button under Further functions.

3.5.6 Creating a New Safety Function, Layout Definition

Prior to creating the safety function, the safety function layout has to be defined. To ease further entries, the combinations below are available in addition to the standard layout of **DETECTION** > **EVALUATION** > **REACTION** (consisting of three sub-systems or SRP/CS):

- **DETECTION+EVALUATION** > **REACTION** With this combination, the detection and evaluation sub-functions are summarized and only devices which combine these functions are suggested to you (e.g. SIRIUS standstill monitor 3TK2810).
- **DETECTION** > **EVALUATION+REACTION** With this combination, the evaluation and reaction sub-functions are summarized and only devices which combine these functions are suggested to you (e.g. frequency converter SINAMICS G120).
- **DETECTION+EVALUATION+REACTION** With this combination, the three sub-functions are summarized and only devices which combine these functions are suggested to you (e.g. safety light curtain with integrated safety controller).
Confirm the selection via the **OK** button.

This Getting Started uses the default layout for the examples of safety functions.

### 3.5.7 Safety Function – General Description Editing

The term safety function refers to a summarization of the individual sub-systems or SRP/CS under DETECTION, EVALUATION and REACTION.

The following information on the safety function has to be entered under Safety function – General description:

- **Name** of the safety function
- **Operation mode** valid for this safety function
- **Inspector** of the safety function
- **Description** of the safety function
- **Status** of the safety function assessment
- **Version** of the safety function assessment
Note:

The **Last editor**, who is automatically assigned upon login (first name and surname), cannot be edited.

With loaded projects, the **Last editor** is only overwritten by the currently registered user of the Safety Evaluation Tool when project changes are saved.

The safety function safety integrity now has to be selected in accordance with the selected standard.
3.5.8 IEC 62061; Consideration of Safety Integrity

Select the **Required SIL** in accordance with the implemented risk analysis or determine the required SIL by operating the **Find Out** button.

![Determination of the required SIL](image)

**Figure 17:** Defining the required SIL

Then, select the **Sensor – group** in the navigation tree under **DETECTION**.
3.5.9 ISO 13849-1; Consideration of Safety Integrity

Select the Required PL in accordance with the implemented risk analysis or determine the required PL by operating the Find out button.

**Figure 18:** Defining the required PL

Then, select the Sensor – group in the navigation tree under DETECTION.
3.5.10 Sensor Group (S7 – ES Control Device) Editing

In the Sensor group screen, the properties of the sensor (e.g. EMERGENCY-STOP (ES) command unit) for activation of the safety function have to be defined.

The screen layout and values to be entered differ depending on the used standard.

![Editing Sensor Group](image)

**Figure 19: Editing Sensor Group**

The general presets of the screen are as follows:

- **Name** of the sensor group
- **Type** of the sensor
  - Customer data required (wear component)
  - SIL / PL exists (electronic component)
    - When selecting Customer data required, using the pull-down menu, Architecture of the sensor group (1 or 2-channel) must be selected.
    - When selecting Customer data required, using the pull-down menu, the No. of components must be edited.
      - 1-channel architecture → 1 component
      - 2-channel architecture
        - 1 component (channels 1 and 2 are identical)
        - 2 components (identical or different types) with different values (e.g. different actuation cycle)
- **Manufacturer** of the sensor
  - When selecting SIEMENS, the appropriate SIEMENS sensors are recommended with the safety-relevant data.
  - When Third-party manufacturer is selected, the safety-relevant data of the sensor can be freely entered.
  - When Safety-related product library is selected, the safety-relevant data of the sensor is imported from an OEM device manufacturer file (*.xml) in VDMA format.

The different versions are subsequently explained in detail.
Manufacturer = **SIEMENS**

**Figure 20:** Selecting SIEMENS as Sensor (e.g. Pushbutton with S7 connection, ET200M)

Complete all of the fields displayed below. Help when completing the fields is available using the tool tips for these fields and the Help button.

- **To determine the DC and the CCF factor,** the corresponding selection screen forms are available (Estimate DC or Estimate CCF button)

- **S7 connection** (only for sensors without integrated communication connection), using this field, you can specify whether the sensor is connected to a failsafe PLC via a failsafe digital input module. When activated, under EVALUATION, a partial system and/or SRP/CS is created for the failsafe digital input module.

- **Structural restriction** (only for IEC 62061):
  - The selection Yes or Position switch limits the SIL CL to 2
  - The selection None or Emergency Stop does not limit the SIL CL
  - Also see Help

Then, in the navigation tree, under **EVALUATION,** select **S7 – ES command unit.**

Note:

When selected “S7 Connection” you **cannot copy** the sensor-group! Instead of that, you select under the sensor group the necessary module (e.g. ET200M) separately. **In this case you will see for „S7 Connection“**
Manufacturer = Third-party manufacturer

![Safety Evaluation Tool](image)

**Figure 21:** Selecting Third-Party manufacturer for Sensor-type

Complete all of the fields displayed below. Help when completing the fields is provided using the tool tips to the fields and the Help button. You can obtain the corresponding values from the component supplier.

- In the field next to **Third-party manufacturer**, enter the manufacturer’s name
- Under **Fault rate calculator** you can select which value should be used to calculate the fault rate. The fault rate can be calculated using:
  - B10
  - B10d
  - MTTF
  - MTTFd
  - MTBF
  - λD
- To determine the **DC** and the **CCF Factor**, the corresponding selection screen forms are available (Estimate DC or Estimate CCF button)
- **Structural restriction** (only for IEC 62061):
  - The selection **Yes** or **Position switch** limits the SIL CL to 2
  - The selection **None** or **Emergency Stop** does not limit the SIL CL
  - Also see Help

Then, in the navigation tree under **EVALUATION**, select **Logic – group**.
Manufacturer = OEM device selection by XML import

If you have imported a XML file with safety-related product values from your external OEM device manufacturer you can now choose your safety sensor product directly, like in the steps before. Please follow the instruction of the OEM device manufacturer for any selection criteria!

Do the same settings, as in the description before, for the relevant parameters (e.g. test intervals, ratio, CCF, etc.) respectively the selection criteria to reach the required safety category.

Note:

Consider the product information from your OEM device manufacture!
Please note that the SET Safety Evaluation Tool does not check whether the data imported from external manufacturers are complete, correct, topical and/or usable.
3.5.11 Logic Group (S7 – ES Command Device) Editing

Due to selection of the **S7-Connection** in the *Sensor group*, a sub-system or SRP/CS was automatically created for the failsafe digital input module “S7 – Emergency Pushbutton Control Device” under **EVALUATION** group (see figure 25).

The screen layout and values to be entered differ depending on the used standard.

**Figure 23:** Setting the S7-ES Pushbutton Logic evaluation (from S7 Connection, ET200M, F-DI24)

Fill in all fields. Help is provided by the tool tips on the fields and via the **Help** button. Then, select the **Logic – group** in the navigation tree under **EVALUATION**.

3.5.12 Logic Group (S7 – Controller) Editing

In the *Logic group* screen, the properties of the safety function evaluation logic (e.g. safety relay, failsafe CPU) have to be defined.

The screen layout and values to be entered differ depending on the used standard.
Figure 24: Editing the S7-CPU Logic controller (e.g. S7 – F-CPU, CPU317F-2DP/PN)

The general pre-settings of the screen are as follows:

- **Name** of the logic group
- **Manufacturer** of the evaluation logic
  - When **SIEMENS** is selected, the corresponding SIEMENS evaluation units (e.g. S7-CPU, MSS, 3RK12, etc.) are recommended with the safety-relevant data.
  - When **Third-party manufacturer** is selected, the safety-relevant data of the evaluation logic can be freely entered. Details on the **Third-party manufacturer** are provided in Chapter 3.4.8.
  - When **OEM device Manufacturer** is selected, the safety logic controller is inserted via XML file import (VDMA format) form a OEM device manufacturer.

Next, fill in all fields. Help is provided by the tool tips on the fields and via the **Help** button.

Then, select the **Actuator – group** in the navigation tree under **REACTION**.

### 3.5.13 Integrating products from an imported database for safety-related values

To select OEM devices from an imported XML database (VDMA format) for safety-related values, instead of selecting "Manufacturer direct input" as before, the user now selects the manufacturer that has been imported from the drop-down menu (refer to the following figure).

![Select manufacturer](image)

**Figure 25**: Select manufacturer, e.g. Bihl+Wiedemann logic controller

After selecting the manufacturer, the product parameters are selected, see "Product parameters" diagram. Selection criteria 1 – 5 are set according to the technical description of the product manufacturer.
When necessary, take into consideration additional technical data of the manufacturer and OEM information about the product! For the settings of the criteria 1 - 5 please take care about the requirements from your OEM device manufacture to reach the safety level.

When done, you forward with REACTION and the Actuator – Group selection.

### 3.5.14 Actuator Group (Drive) Editing

In the Actuator group screen, the properties of the safety function actuator (e.g. line contactor, failsafe drive) have to be defined.

The screen layout and values to be entered differ depending on the used standard.
- **Name** of the actuator group
- **Type** of the actuator
  - *Customer data required* (electromechanical component)
  - *SIL / PL exists* (electronic component)
- **Manufacturer** of the actuator
  - When *SIEMENS* is selected, the corresponding SIEMENS actuators with the safety-relevant data are recommended.
  - When *Third-party manufacturer* is selected, the safety-relevant data of the actuator can be freely entered (e.g. with non-SIEMENS components). Details on *Third-party manufacturer* are provided in Chapter 3.4.8.
  - When *OEM device manufacturer* is selected, the safety actuator is inserted via XML import (VDMA format) form an OEM device source.
- **S7-Connection** (only actuators without *Integrated communication connection*) – in this field, you can specify whether the actuator is connected to a failsafe PLC via a failsafe digital output module. Upon activation, a sub-system or SRP/CS is automatically created for the failsafe digital output module under **EVALUATION**.
Next, fill in all fields. Help is provided by the tool tips on the fields and via the Help button.

- For SINUMERIK 828D, SINUMERIK 840D sl and the modular failsafe drive systems SINAMICS S110, SINAMICS S120 AC/AC and SINAMICS S120 modular, from Version V2.0 of the Safety Evaluation Tool, a wizard is available, which supports you when selecting safety-relevant components. It goes without saying that the required components can also be directly selected as before.

The selection Wizard is opened by clicking on the symbol 📊.

![Figure 28: Selecting the Drive Wizard (for Drives only)](image)

- The dialog that is now displayed allows a structured selection of the relevant system components (here, using the selection screen form for SINAMICS S110 as example). Please note that when opening the dialog again, the previously entered information is no longer available.

![Figure 29: Setting the Drive Wizard](image)

- The dialog also checks whether all of the required system components have been selected. As long as this is not the case, the following message is displayed, and the system prevents the dialog from being exited.
As soon as the selection has been completed, after pressing the **OK** buttons the dialog is closed and the selected components appear in the project tree below **EVALUATION** or **REACTION**.

Under **NAME** now allocate the appropriate designations for the automatically inserted partial systems and/or SRP/CS corresponding to your particular system or machine – and then complete the entries by editing the fields in yellow with the "Please choose" text.

Note:

The Safety Integrated Basic Functions of the drives do not require an encoder. In this case, for encoder system you must select "No encoder required". This selection only serves to complete the check. As a consequence, after exiting the dialog, an SRP/CS is not created.

On the other hand, selecting "Sensorless motion monitoring" simultaneously includes a PFH value. After exiting the dialog, a partial system or SRP/CS is created for this purpose.

The selection wizards for SINUMERIK 828D, SINUMERIK 840D sl and for SINAMICS S120 modular in principle has a similar structure. However, here you can also enter the required number for most system components.
Note: The selection Wizard for SINAMICS S120 modular includes basic plausibility checks, e.g. whether the number of selected encoder systems matches the number of Motor/Power Modules.

It cannot replace the SIZER engineering tool in which the complete system knowledge is saved.

- **S7 connection** (only with actuators without integrated communication connection). In this field, you can state whether the actuator shall be connected to a failsafe PLC via a failsafe digital output module. When activating the field, a subsystem resp. SRP/CS is automatically created for the failsafe digital output module during the evaluation.

No Wizard is provided for the integration of an actuator from an external manufacturer. Integrate the safety-related actuator of an XML parameter library just like an external sensor or an external logic unit.

The following figure shows how to select an external actuator.

![Figure 31: Selection of an OEM device – actuator via XML Import (e. g. B+W Safety monitor)](image)

When using safety equipment from competitors, you can enter these conveniently in the subsystem REACT, as already shown in the other subsystem.

Safety equipment which has been integrated in the SET via an XML parameter library import is also selected via the manufacturer and the correct setting of the selection criteria (observe the manufacturer’s specifications!).

Then, select the safety function level, in this example Emergency Stop, in the navigation tree for display of the calculation result.
3.5.15 Result

The result of the safety integrity consideration is displayed in the overview screen of the safety function, in this example Emergency Stop, in the form of the Achieved SIL or PL and Achieved PFH\(_D\).

The screen layout red differs depending on the used standard.

![Safety Evaluation Tool](image)

**Figure 32:** Final Actuator – Group (made with Drive Wizard)

Note:

In the screens, the calculation results are only displayed with two decimal places.

However, the Safety Evaluation Tool internally uses more than two decimal places.
### 3.5.16 Create Report

To generate the result report, select the respective project in the navigation tree, in this example Company XY, and select the **Create report** button.

**Report**

Date: 8/26/13

**Safety Evaluation Tool**

<table>
<thead>
<tr>
<th>Name:</th>
<th>Project IEC62081</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety standard:</td>
<td>IEC 62081, Safety of machinery - Functional safety of safety-related electrical, electronic and programmable electronic control systems</td>
</tr>
<tr>
<td>Manager:</td>
<td>Paul Manager</td>
</tr>
<tr>
<td>Inspector:</td>
<td>Jeff Inspector</td>
</tr>
<tr>
<td>System type:</td>
<td>Machine General</td>
</tr>
<tr>
<td>Document risk analysis:</td>
<td>Risk_Analyse.doc</td>
</tr>
<tr>
<td>Description:</td>
<td>Optional description (e. g. place of installation, environmental informations, etc.)</td>
</tr>
<tr>
<td>SET version:</td>
<td>2.3.0-20130522</td>
</tr>
<tr>
<td>Product data version:</td>
<td>0.53</td>
</tr>
</tbody>
</table>

**Table of contents**

1. Safety functions          (page 3)
2. Approval                  (page 4)
3. Annex functions           (page 5)
4. Annex subsystems          (page 6)
5. Annex order lists         (page 11)

**Figure 33:** Report out of Safety Evaluation Tool

The signed report should be added to the Technical Documentation of the machine/system as confirmation.
4 Appendix

4.1 References

This list is by no means complete and merely represents a selection of suitable literature.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basics</td>
<td>Reference book: Functional Safety of Machines and Systems Order No.: A19100-L531-B123 (can be ordered via your SIEMENS contact partner)</td>
</tr>
</tbody>
</table>

4.2 Internet Links

<table>
<thead>
<tr>
<th>Subject</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Evaluation Tool</td>
<td><a href="http://www.SIEMENS.com/safety-evaluation-tool">http://www.SIEMENS.com/safety-evaluation-tool</a></td>
</tr>
<tr>
<td>Safety Integrated website</td>
<td><a href="http://www.SIEMENS.com/safety-integrated">http://www.SIEMENS.com/safety-integrated</a></td>
</tr>
<tr>
<td>MTBF value for SIEMENS components</td>
<td>The corresponding values are also available on the CS Internet pages (search term: MTBF)</td>
</tr>
<tr>
<td></td>
<td><a href="https://support.automation.SIEMENS.com">https://support.automation.SIEMENS.com</a></td>
</tr>
</tbody>
</table>

4.3 History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>April 2009</td>
<td>First issue</td>
</tr>
<tr>
<td>V2.0</td>
<td>June 2011</td>
<td>Update for SET V2.0</td>
</tr>
<tr>
<td>V2.1</td>
<td>November 2013</td>
<td>Amendment XML safety-related product data import (neutral data interface) function</td>
</tr>
</tbody>
</table>